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The Napa Valley Personal Computer
Users Group has served novice and
experienced computer users since 1983.
Through its monthly meetings,
newsletters, online forum, special
interest groups, mentor program and
community involvement, it has helped
educate people of all ages. The
NVPCUG provides opportunities for
people to find friends who share
common interests and experiences.
From January 2003 to October 2007
the NVPCUG provided 783 computers
and 140 printers to local schools.
Additional equipment has been given
to charitable nonprofit organizations
and to disadvantaged individuals.

At our July general meeting we
will have a very special forum.
The time will be divided between
the Computer Tutor session and
Q & A.
The Computer Tutor session
will be presented first.
Jeff Solomon will be
demonstrating and
discussing several
different
Internet
Browser options such
as Mozilla Firefox, Opera, and Safari. Please send your ideas
to the Computer Tutor, Jeff Solomon at
tutor@nvpcug.org.
The Tutor Session will be followed by a
Q & A panel. Our Random Access moderator,
Jerry Brown will be joined by a panel of several
well experienced computer
members, some of whom work with computers
at a professional level. Bring your
questions to the July 16 meeting or
submit them before Jerry Brown at
Questions@nvpcug.org.
Could you use some practical information that would help you
make better use of your computer? Come to this meeting! Guests
are always welcome. Admission is always free.
Interested in becoming a member? See page 14 for application
information.
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President’s Message

By Ron Dack, president, http://www.nvpcug.org/,
President@nvpcug.org
The
summer
is
in
full
swing
and
our
State
is
burning
up
In SIG meetings you can learn about
and
smoking
up.
Well
so
much
for
quitting
smoking
in
a subject in greater detail than is
1983.
I
have
one
of
those
wonderful
summer
colds
that
feasible at NVPCUG general
meetings. SIG meetings are open to was probably brought on by doing my mandatory walks
everyone. M e e t i n g t i m e s a n d in the beginning of our smoke filled valley last week. I
locations occasionally change, so asked the Board of Directors to cancel the July Board
for current meeting information, see meeting both because of this cold and there was no
critical issue to discuss this month. As far as the group is concerned everything
our Web site, www.nvpcug.org, or
seems to be doing quite well (Knock-Knock).
contact the SIG leaders.
The last time we used the projector I noticed it is becoming increasingly
Investors SIG
more difficult to see a true picture of what is on the computer that is running
Meets: Monthly, second Monday
the display. The brightness and contrast controls have less and less effect on
5:30 to 7:30 p.m
the picture. That of course means the projector is closing in on its end of life.
Jerry Brown’s home,
Don’t panic though because the decreasing cost of quality projectors coupled
with the willingness of most of you to help the group survive we are now
23 Skipping Rock Way, Napa
operating in the black and will probably be able to replace our projector.
Leader: Jerry Brown
Susy Ball is looking into different models and the possibility of getting a
(707) 254-9607
non-profit discount or maybe even donated projector.
bqandjbb@sbcglobal.net
Remember the Annual NVPCUG Member’s Picnic is coming up soon.
Digital Photography SIG
Dianne Prior will again be coordinating this event. It’s not too early to
Meets: Monthly, second Wednesday
decide what you will bring and what you will do to help make it a great
7:00 to 8:30 p.m
picnic. Mike Ball will be our barbecue chef.
Piner’s Nursing Home,
Dawna and I are watching for Tri-Tip on sale we usually buy the roast
Conference Room
and cut it up ourselves so if you see Tri-Tip roasts on sale let me know. We
1800 Pueblo Ave., Napa
are also looking forward to helping Susy Ball apply her “secret” marinade to
Leader: Susy Ball
the meat again this year. Mark your calendars the picnic will be in August on
(707) 337-3998
Saturday the 23rd from 1PM to 6PM. If you are a member and you want to
susyball@aol.com
attend you should signup at one of the next two meetings or e-mail Dianne
Prior at Prior@napanet.net.
Napa Valley Mac User Group
We are looking for a wireless microphone to use at the meetings so if you
Meets: Monthly, second Thursday
have
one sitting around and would like to donate it we would be more than
6:30 - 8:30 p.m.
happy
to put it to good use.
Napa Senior Activity Center
I
contacted
the City and asked if some curtains can be put on the
1500 Jefferson St., Napa
windows
of
the
meeting room so no one is blinded during the meetings. Ron
Leader: Ron Rogers
Rogers
of
the
NVMUG
has also asked for this to be done. Both groups have
(707) 226-5352
offered
to
cover
the
expense
and the organization that paid to have the bocce
ronrogersnapamug
ball
area
covered
said
they
would
be willing to cover the entire cost.
@gmail.com
If you have any comments or ideas about improving the group in anyway
let me know. You can e-mail me at President@nvpcug.org. I hope to
see each of you at the general meeting on Wednesday July 16th 7PM at the
Senior Activity Center.

NVPCUG General Meetings
Take care,
Held the third Wednesday of each month, 7:00 to 9:00 p.m.
Napa Senior Activity Center, 1500 Jefferson Street, Napa

Ron

NVPCUG Calendar
July 16
Aug 6
Aug 11
Aug 13
Aug 14
Aug 20

7:00-9:00 p.m.
7:00-9:00 p.m.
5:30-7:30 p.m.
7:00-8:30 p.m.
6:30-8:30 p.m.
7:00-9:00 p.m.

Sept 17

7:00-9:00 p.m.

NVPCUG General Meeting + A
Board of Directors meeting + B
Investors SIG meeting + C
Digital Photography SIG meeting + B
Napa Valley Mac User Group + A
NVPCUG General Meeting + A
NVPCUG General Meeting + A
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Meeting Locations
A - Napa Senior Activity Center,
1500 Jefferson Street, Napa
B - Piner’s Nursing Home,
1800 Pueblo Ave., Napa
C - Jerry Brown’s home,
23 Skipping Rock Way, Napa

Napa Valley Personal Computer
Users Group Contact Information
Officers for 2008
Board of Directors
President
Vice President
Secretary
Treasurer
Other Directors:
Director

Ron Dack
unlisted
President@nvpcug.org
Dick Peterson
738-1812
VicePresident@nvpcug.org
Marcia Waddell 252-2060
Secretary@nvpcug.org
Roy Wagner
253-2721
Treasurer@nvpcug.org
Susy Ball, Ron Dack, Jim Gray, Dick Peterson, Bob Simmerman,
Kathy Slavens, Dean Unruh, Marcia Waddell, and Roy Wagner.
Jim Gray

unlisted

Director_Gray@nvpcug.org

Appointed Officers
Computer Tutor Coordinator
Jeff Solomon

553-2114

Tutor@nvpcug.org

Facility Arrangements Coordinator
Dianne Prior
252-1506

Facility@nvpcug.org

Greeter Coordinator
Kathy Slavens

251-9193

Greeter@nvpcug.org

Greeter Coordinator
Bob Simmerman 259-6113

Greeter2@nvpcug.org

Librarian
Dean Unruh

226-9164

Librarian@nvpcug.org

Membership Director
Bob Simmerman 259-6113

Membership@nvpcug.org

Newsletter Circulator
Jim Hearn

224-2540

Circulation@nvpcug.org

Newsletter Editor
Susy Ball

337-3998

Editor@nvpcug.org

Product Review CoCoordinator
Susy Ball

337-3998

Reviews@nvpcug.org

Product Review CoCoordinator
Marcia Waddell

252-2060

Reviews2@nvpcug.org

Programs Director
Susy Ball

337-3998

Programs@nvpcug.org

Publicity Director
Ron Dack

unlisted

Publicity@nvpcug.org

Random Access Moderator
Jerry Brown

254-9607

Questions@nvpcug.org

Special Projects Director
VOLUNTEER NEEDED

Projects@nvpcug.org

Webmaster
Ron Dack

unlisted

Sales Coordinator
VOLUNTEER NEEDED

Webmaster@nvpcug.org
sales@nvpcug.org

• All telephone numbers are in Area Code 707.
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Users Group, Inc.
(NVPCUG), P.O. Box
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be reproduced without
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except that permission
for reproducing articles,
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credited, is granted to
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nonprofit use only. The
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newsletter is believed
to be correct. However,
the NVPCUG can
assume neither
responsibility for errors
or omissions nor liability
for any damages
resulting from the use
or misuse of any
information.
The NVPCUG is an IRC
501(c)(3) tax-exempt
nonprofit educational
organization (EIN 680069663) and is a
member of the
Association of Personal
Computer User Groups
(APCUG), an
international
organization. Donations
to the NVPCUG are
tax-deductible as
charitable contributions
to the extent allowed by
law. Copyright © 2007
by NVPCUG.

Uniblue Registry Booster 2

By Terry Currier, Vice President & Webmaster, WINdows usERS (WINNERS), CA,
www.windowsusers.org/, Tcurrier@aol.com
Obtained from APCUG with the author’s permission for http://www.liutilities.com/products/
publication by APCUG member groups.

I’ve tested a number of programs on my
secondary test computer over the years. I’ve
also installed and uninstalled a number of
programs. At start up the computer loads up
my anti-virus, anti-spyware, firewall, UPS
monitor, motherboard monitor, QuickTime,
Intel graphics monitor, Maxtor storage
monitor, printer software, TV software, and
others. It takes a while for it to boot up. I turn
it on when I need it, go away to do other
things, and come back after it’s ready.
Rebooting is even longer with it shutting
down everything and restarting. So I thought
Uniblue RegistryBooster 2 would be
something good to try. Rebooting took 4
minutes 45 seconds. When I first ran
RegistryBooster it found 459 Problems/
Errors. The vast majority being Missing or
Invalid Path.
The Windows Registry in a broad sense is
a database of the hardware and software on
your computer. It contains all your settings
for windows and other software. Whenever
you install new software it creates new
settings in the registry. When you uninstall
software it removes all those registry settings
associated with the software, right? Well it
does uninstall the programs, removing it
from the hard drive. Most really do very little removal from
the registry. So the software is removed, but the settings are
still in the registry and you have a bunch of orphan links.
Even before I installed RegistryBooster 2 I did a backup,
for safety sake. It also can create a backup of the registry
before you have it do any repairs. It can create up to eight
backups, keeping the most recent. Before running it my
reboot time was 4 minutes 45 seconds. After running and
fixing what it said were problems I also used it to defrag the
registry. Using RegistryBooster 2 (twice) my reboot time
was down to 3 minutes 39 seconds, saving 66 seconds. Okay
that’s great, but for a program like this you want to make
sure there are no problems later. So I’ve used this for two
months now and I can say I’ve had no problems. I’ve run it
about ten times total. Each time I chose to trust the program
with what it said was a problem.

Conclusion
RegistryBooster 2 is very easy to use, and at $29.95 it is a
good value.

registrybooster/
Supported Systems:
Windows 2000 Windows XP
Windows Vista 32-Bit
Recommended Requirements:
Intel Pentium 4 1GHz or Equivalent processor
512 MB RAM
200 MB free hard disk space
Graphics mode 1024x768 true color (highest 32-bit)
Microsoft Windows 2000 / XP / Vista (32-bit)
Internet Explorer 6

Terry Currier is currently Vice-President & Editor of
WINNERS – WINdows usERS which meets in Fountain
Valley, California. He has been a member of computer user
groups since 1984 (months before he even brought a
computer.)
This article has been provided to APCUG by the author solely
for publication by APCUG member groups. All other uses
require the permission of the author (see e-mail address above).
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Skype 4.0

By Joe Nuvolini, Webmaster & APCUG Rep, Pikes Peak Computer Application Society, CO,
http://ppcompas.apcug.org/, nuvo@nuvolini.com
Obtained from APCUG with the author’s permission for and it seems to work real well. This full screen mode
will be very useful for the computer user group
publication by APCUG member groups.
I’ve been a Skype subscriber for some time now. What is community.
While at the Association of PC User Groups (APCUG)
Skype, you say? Well, it’s an online chat/phone/video Convention held in conjunction with the January 2008
service which has, as of the end of March, some 309 Consumer Electronics Show (CES) attendees in their
million registered users. Last I heard, that is more forum with the vendors discussed presentations at user
subscribers than all the US telephone services combined! group meetings. Over the years, the cost of sending
It allows you to make computer to computer calls free representatives out to user groups for the purpose of
promoting their wares has become no longer cost
worldwide. It can support 12 million users at
effective. We discussed the use of Webinars
a time. In addition to audio and video chat,
(live presentations across the Internet).
you can instant message, send text messages
This new version of Skype looks to be ideal
to phones, and share files. You can call from
for such a program and it can be done at
computer to phone as well.
little or no cost to the vendors and user groups. If you
haven’t tried Skype, you should. You can download the
It has three levels of service for the computer to phone
current version (3.8) at: http://www.skype.com/
service. For $295 per month you can make free
computer to phone calls anywhere in the US and
download/skype/windows/. If you are
Canada. The $5.95 service includes the US, Canada, and adventurous and want to try 4.0 beta go to: http://
Mexico City, Guadalajara, and Monterrey Mexico. For
www.skype.com/intl/en/download/skype/
$9.95 per month you get unlimited free computer to
windows/bets/.
phone calls worldwide. They point out that unlimited
By the way, if you have wireless Internet access you
means up to 10,000 minutes per month. Let’s see,
can purchase a WiFi phone at the Skype online store
10,000 minutes is over 6.9 days! I’m currently
and it will allow you to make calls whenever and
subscribing to the $2.95 service. To call overseas with
wherever you have wireless Internet access. There’s a
my service it runs about 2.1 cents per minute to Europe lot more information which you can checkout at their
or from Europe back to the States. Skype has been
Website: http://www.skype.com.

offering video calling as well since 2005. Their data
This article has been provided to APCUG by the author solely
compression allows quality voice transmissions on a
for publication by APCUG member groups. All other uses
bandwidth of as little as 2kbs and video on 6kbs. It has
require the permission of the author (see e-mail address above).
a new version, 4.0, which is in beta testing. It allows
Editor
s Note: This article may provide insight for those
Editors
you to see the person you are calling full screen. For
that missed the last general meeting.
this feature to work well you need 90kbs. I’m using it

Tables In Word
Tools such as Microsoft Word 2003 offer a variety of
standard formats that can be applied to tables. Just
click anywhere in your table and then click Table and
Table AutoFormat. A formatting dialog box will appear,
so you can select from a variety of established format
styles. Examples are shown for each format, so you
can experiment with different looks until you find the
one that suits the situation best. When you decide on
a format, click Apply to reformat your table. If you
make a mistake or change your mind, click Undo and
repeat this process to apply another table format.

Microsoft Word Documents
The easiest way to see a document’s creator is simply
to check its properties. Open the document in Word
and go to File and Properties. Select the Summary tab
to learn about the document’s creator, along with
managerial and search-related information. Other tabs
can reveal statistical information about the file, content
summaries, and other details. Remember that much of

the information available in these dialog boxes has to
be entered by the original document’s creator, so some
of the details may be quite sparse. Document
permissions may also prevent you from editing or
altering those details, so if you plan on editing these
details, be sure that the document’s author does not
invoke protections.

Word Formatting
Microsoft Word 2000 and later versions all offer a
quick and easy way to remove all formatting from a
document. Select the portion of the document you
want to work with. (Use the mouse to select desired
paragraphs or just press CTRL-A to select the entire
document.) Now press CTRL-SHIFT-N to undo all of
the formatting. This will not undo font styles, sizes,
and other specific items, but it should clear paragraph
spacing and other general format features.
Reprinted with permission from Smart Computing. Visit
www.SmartComputing.com/Groups to learn what
Smart Computing can do for you and your user group!
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Painter 4 Essentials, a First Impression
By Dave Chalmers, Editor, Kern Independent PCUG, CA, www.kipug.org,
newsletter@kipug.org
Obtained from APCUG with the author’s permission for
publication by APCUG member groups.

Corel’s demonstration of their
products at the recent Southwest
Computer Conference showed
one new product that really
interested me. Corel Painter 4
Essentials is a real painting
program, not a photo editing
program. It has the features of
being able to paint or draw with
a computer. If you have a shred
of drawing talent, you might
really like this program.
Now I have no talents this
way unfortunately. Why I would
buy a program like this, being a
photographer, might surprise
you. Painter has a great feature
that will auto paint or draw from
a photo. In this mode you pick
a style from many artistic
techniques and stand back.
Will this look great for all
photos? The simple answer is
no. If you have a lousy picture
you will probably end up with a lousy painting. Photos that
are dependent on a lot of fine detail to work will also not
be a good candidate for this product. Simple landscapes or
portraits or more abstract photos will probably work the
best. Now having said that, there are always exceptions
that will work, trying the process only takes some time.
You start with a photo that has been corrected and
cropped using a photo editing program. Jpeg’s, tiff, and
PhotoShop psd files will work. Just open them in Painter
and start selecting the artistic medium you want. Once the
program commences you will see a very blobby and
abstract image in the beginning. As the process continues,
details emerge; you can stop the drawing at any time or let
it go to completion. Once done you can go into using your
own painting efforts to add or subtract details to enhance
the painting. A good example of this would be a portrait.
Increasing the details around the eyes usually helps the
overall composition. If some of the background contrasts
too much with the person, you can blur and tone down the
background.
A graphic tablet is a real plus with Painter, as it uses the
stylus for changing the brush characteristics, as you go. A
mouse works fine, but it doesn’t have as much flexibility
as the tablet. Wacom makes some tablets that are fairly

inexpensive. Please note, a tablet is not required to get this
program to work.
Printing with this program is
quite simple. It doesn’t have a
dedicated color management
system as more expensive
programs, but if you can print a
good photo, then printing with
Painter is no problem.
Painter comes with some
excellent video tutorials that
really clue you in on the features
and give a great how-to aspect
to it. They are logically arranged
and each segment is not too
long. Painter even comes with
a nice printed manual, with
illustrations. The manual
generally follows along with
the tutorials.
Retail price is $99 and the
member price is $79. It installs
on both PC’s and MAC’s. As
a supplement to a photo
editing program, I certainly
recommend it.

This article has been provided to APCUG by the author solely
for publication by APCUG member groups. All other uses
require the permission of the author (see e-mail address above).

Screen Flicker
One of the causes of screen flicker, especially on CRT
(cathode-ray tube) monitors, is a screen refresh rate
that is set too low. In general, it’s best to set the refresh
rate to the highest possible setting. In WinXP rightclick the Desktop, click Properties, choose the Settings
tab, click the Advanced button, and choose the Monitor
tab. If you see a Hide Modes That This Monitor
Cannot Display checkbox, select it. In the Screen
Refresh Rate drop-down menu, select the highest
possible rate available. Click Apply, and if prompted,
click Yes to keep the new settings. Click OK to close
the dialog boxes and save your settings. In Win98
right-click the Desktop, click Properties, choose the
Settings tab, click the Advanced button, and choose
the Adapter tab. Select the highest refresh rate from
the drop-down menu, click Apply and OK.
Reprinted with permission from Smart Computing. Visit
www.SmartComputing.com/Groups to learn what
Smart Computing can do for you and your user group!
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I’M ASKED...
By Bill Funk, a member of the Arizona Association for Computer Information, inc. (ASCIi),
www.asciigroup.org, editor@asciigroup.org
Obtained from APCUG with the author’s permission for
The way you’re doing it will make
publication by APCUG member groups.
the flash act as a “fill” flash, meaning
the camera’s exposure system will
use the existing light in the scene to
set the exposure, and the flash will
intelligently fire to fill in shadows,
but not be the major source of light in the scene. This is also
the usual way the camera’s on-board flash works, even
though many cameras will set the shutter speed to take
advantage of the flash’s extra light to help freeze motion.
The problem here, though, is that the on-board flash just
isn’t bright enough to light up a dark scene (such as a room)
I just bought a very well.
Digital SLR; with
One of the really neat things about digital photography is
the prices as low as that, regardless of the actual type of the camera,
they are, I couldn’t experimentation is cheap. In this case, once you get the
resist. Since I want basics of flash use down, you can experiment with different
to take photos of shutter speeds and aperture settings for different results.
my grandchildren, Also, off-camera flashes like yours will usually let you turn
and the built-in flash isn’t the flash head up and down, and side to side, for bounce
as powerful as I need, I flash. With bounce flash, you’re bouncing the flash off the
bought a new flash. It’s the ceiling or wall. This tends to spread the light from the flash
same brand as my camera, out to reduce that sharp look that a straight-on flash gives,
and is supposed to be all and it also reduces harsh shadows (as well as changing
automatic. But, the photos aren’t right. I thought the better where the shadows are); more to experiment with!
flash would let me take photos inside, and freeze the
This brings up another question: if you have an older
movement of the grandkids, but the photos are as blurry as flash from your film days, can you use it with your new
with the camera’s flash.
DSLR? The answer is a very firm: maybe. The problem
is that most older, film-era flashes have a higher trigger
What’s going on?
voltage than what DSLRs can tolerate. In other words,
You’re right, the on-board flashes on most DSLRs aren’t using that old flash can cause some expensive damage to
very bright. Buying the new flash is the right idea, but it your DSLR. There are some devices that can be put
doesn’t work the way many people think it does.
between your older flash and your DSLR’s flash shoe
You’re probably using the camera as a Point & Shoot: that will solve the problem. However, a new flash will
setting the camera to make the exposure decisions, and also work much better with your new DSLR, and do
pressing the shutter button. There’s nothing wrong with things that old flash can’t even dream of doing.

that, but doing things that way won’t get your flash to work This article has been provided to APCUG by the author solely
the way you want it to.
for publication by APCUG member groups. All other uses
Instead, you should use the Manual mode for exposure require the permission of the author (see e-mail address above).
(check your camera’s manual for how to enter the Manual
Focus Your Test Shots
mode). While you’re looking at the manual, check to find
Your camera’s autofocus system might not work very
the highest shutter speed you can use with the flash, too.
well when it doesn’t have well-defined subjects to
Then, in Manual mode, set the shutter speed at, or maybe
target, so make sure you know how to use the manual
slightly below, that speed ( I use 1/125 sec on my camera;
focus capabilities. To do this with most point-andit’s fast enough to freeze most action), then set the aperture
shoot models, you have to turn off the autofocus and
(f/number) for the desired result as far as depth of field is
then use one or two control buttons to adjust the focus
concerned, and set the ISO as desired. Set the flash to auto
on your own. After you take a couple of test shots, use
(check the manual), and fire away. This way, the camera will
the playback mode and zoom in on your images to
use the settings you chose, ignoring the amount of light in
make sure they’re sharp.
the scene. The flash will check to see what the camera is set
to, and fire itself, checking the results as it fires to give the
Reprinted with permission from Smart Computing. Visit
www.SmartComputing.com/Groups to learn what Smart
right amount of light to the scene. Neat, eh?
Computing can do for you and your user group!
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Viewing the Bigger Picture
By Bonnie L. Snyder, P*PCompAS, Colorado Springs, CO, http://
ppcompas.apcug.org/, Bonniels21@gmail.com
Obtained from APCUG with the author’s allows for an additional option: speech along with the
permission for publication by APCUG magnification. This program is called iZoom, and can be
member groups.
obtained from http://www.issist.com/. I really
At the risk of being the bearer of bad news, I have to say that like the customizing options available in iZoom. These can
none of us is getting any younger. User groups tend to be be accessed from the initial menu when iZoom comes on, or
populated more by senior citizens than by any other age group. once the menu is closed, you can reopen it quickly by
As we age, we find the need for more and more assistive aids, clicking the mouse on the iZoom icon in the system tray.
including those that will help us to use our computers more Here are the option screens:
comfortably and efficiently.
Many of us will find, as time goes on, that our vision is not
what it used to be. We may find that our eyes fatigue as we read
information on the computer monitor, and we may find that
some of the smaller fonts and graphics on the screen require us
to squint and lean forward into the display.
In this article, I will discuss two screen enlargement
programs that might help us minimize our visual difficulties
as we use our computers.
The first program I want to talk about is called Magic Lens
Max. I downloaded an older version of the program from
Giveawayoftheday.com and was very impressed with what it
could do. I e-mailed the program’s author and told him what a
terrific program it was and I have demonstrated it to various
groups who provide services to the blind and visually impaired.
Additionally, the cost of the program is only $3995. I went ahead
and purchased a copy of the most recent edition and was even
more pleased with what the author had added since my iZoom allows for default or customizable hot keys, several
downloaded version.
sizes and colors of mouse pointers, color combinations
Magic Lens Max provides a variety of ways to magnify the supplied with the program, as well as custom color modes,
computer screen, from resizable moveable lenses, which several sizes and shapes of “locators” that help the user find
magnify directly over where your mouse or cursor is working, the location of the mouse pointer, and a choice of several
to a full screen magnification option, which slows down the lens shapes, as well as full-screen magnification. iZoom
screen refresh very minimally. You have some color contrast magnifies from 1X to 32X.
options to choose from with this program as well as an invert The negatives I have found in iZoom are as follows: First,
colors option for light text on dark background. The when using the lens mode, you have to place the lens first
magnification levels can be selected from 50% (which is non- over what you want to interact with, and then move the
magnification) up to pretty much infinity. Anything above mouse pointer within that lens. Second, from about the 3X
350% starts to blur a bit, although there are options to sharpen. magnification up, the display becomes more and more
Below is the Magic Lens
pixilated which can be a problem for some vision
Max option screen:
conditions, such as astigmatism, among others. Third, there
is only one voice offered with the speech option and it is not
The Magic Lens Max
a particularly pleasant one.
icon that resides in the
As you would expect, with additional options comes an
system tray can be singleadditional cost. Again, you can download a 30-day demo of
clicked to turn on or turn
iZoom from the Website, and if you wish to purchase the
off the magnification.
program, the price is $19900. However, keep in mind that the
This is an excellent
two major commercial screen magnification programs, MAGic
program that is both
from Freedom Scientific and ZoomText Plus from AI Squared,
useful and affordable. If
both weigh in at from $30,000 to $55,000, depending on how
you are interested in testing it out, go to
many options you wish to have. So, if you feel the need to view
www.visionsuit.com. You can download a 30-day
the bigger picture, give the demos of the above programs a try,
demo of the latest version. If you decide to purchase Magic
and see if they will be of use to you.
Lens Max, once you have paid the $3995, you will be sent a
registration code that can be entered into the demo, and it
This article has been provided to APCUG by the author solely
becomes fully functional.
for publication by APCUG member groups. All other uses require
The second program I evaluated for screen magnification
the permission of the author (see e-mail address above).
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Email Etiquette
By John Roy, President, The PC Users Group of Connecticut, www.tpcug-ct.org/,
johnroy1@comcast.net
Obtained from APCUG with the author’s permission for
publication by APCUG member groups.

Do you really know how to forward an email? It is estimated that over fifty
percent of email users do not
know how to do it properly. Do you wonder why you
get viruses or junk mail? Email messages get forwarded
countless times without concern for the security of the
previous sender’s addresses.
Every time you forward an e-mail there is information
left over from the people who got the message before you,
namely their e-mail addresses and names. As the messages
get forwarded along the list of addresses builds and builds
creating a huge resource for spammers. All it takes is for
someone to get a virus and the infected computer can send
that virus to every e-mail address that has come across that
computer. Even if the address collection doesn’t result in
a virus it surely will be harvested by spammers or someone
looking to make a couple of cents for a listing of good
email addresses. How do you stop or at least minimize the
propagation of email addresses? There are several easy
steps that we should all practice.
1 Before you send out a forwarded e-mail,
DELETE all of the other addresses that appear
in the body of the message (at the top). That’s
right, DELETE them. Highlight them and delete
them, backspace them, cut them, whatever it is
you know how to do. It only takes a second You
MUST click the ‘Forward’ button first and then
you will have full editing capabilities against the
body and headers of the message. If you don’t
click on ‘Forward’ first, you won’t be able to
edit the message at all.
2

3

4

Whenever you send an e-mail to more than one
person, do NOT use the To: or Cc: fields for
adding e-mail addresses. Always use the BCC:
(blind carbon copy) field for listing the e-mail
addresses. This is the way the people you send
to will only see their own e-mail address. If you
don’t see your BCC: option click on where it
says To: and your address list will appear.
Highlight the address and choose BCC: and
that’s it, it’s that easy. When you send to BCC:
your message will automatically say
‘Undisclosed Recipients’ in the ‘TO:’ field of
the people who receive it.
Remove any ‘FW:’ in the subject line. You
can re-name the subject if you wish or even
fix spelling.
ALWAYS hit your Forward button from the

actual e-mail you are reading. Ever get those emails that you have to open 10 pages to read the
one page with the information on it? By
forwarding from the actual page you wish
someone to view, you stop them from having to
open many e-mails just to see what you sent.
5

Have you ever gotten an email that is a petition?
It states a position and asks you to add your
name and address and to forward it to 10 or 15
people or your entire address book. The email
can be forwarded on and on and can collect
thousands of names and email addresses. A
FACT: The completed petition is actually worth
a couple of bucks to a professional spammer
because of the wealth of valid names and email
addresses contained therein. If you want to
support the petition, send it as your own
personal letter to the intended recipient. Your
position may carry more weight as a personal
letter than a laundry list of names and email
address on a petition. (Actually, if you think
about it, who’s supposed to send the petition in
to whatever cause it supports? And don’t believe
the ones that say that the email is being traced, it
just isn’t so!)

6

One of the main ones I hate is the ones that say
that something like, ‘Send this email to 10
people and you’ll see something great run across
your screen.’ Or, sometimes they’ll just tease
you by saying something really cute will happen
IT AIN’T GONNA HAPPEN!!!!! (Trust me; I’m
still seeing some of the same ones that I waited
on 10 years ago!) I don’t let the bad luck ones
scare me either, they get trashed. (Could that be
why I haven’t won the lottery?)

7

Before you forward an Amber Alert, or a Virus
Alert, or some of the other ones floating around
nowadays, check them out before you forward
them. Most of them are junk mail that’s been
circling the net for Years! Just about everything
you receive in an email that is in question can be
checked out at Snopes. Just go to http://
www.snopes.com/. It’s really easy to find out
if it’s real or not. If it’s not, please don’t pass it on.

So please, in the future, let’s stop or at least minimize
the junk mail and the viruses by taking the steps
outlined above.
This article has been provided to APCUG by the author solely
for publication by APCUG member groups. All other uses
require the permission of the author (see e-mail address above).
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Pinnacle PCTV HD Ultimate Stick
Review
By Bill James, APCUG Director; Editor & Webmaster, Computer Club of Oklahoma City,
www.ccokc.org, bjames@apcug.net
Obtained from APCUG with the author’s permission for Personal Video Recorder (PVR) that allows you to record
publication by APCUG member groups.
up to 2 hours of video. You just plug it in and follow the
Some computer products just have a ‘wow’ factor on first onscreen instructions and start enjoying live TV within
sight; the Pinnacle PCTV HD Stick is one of those devices. seconds. The on-board memory on the Ultimate can also
It is a TV tuner on a USB stick and not
be used to store additional files. You
just any TV tuner but one that is capable
run setup once, even if you use the
of pulling down Standard Definition
device on a different PC, the
(SD) and High Definition (HD)
settings and preference are stored
content to your PC. On seeing
on the device.
the Pinnacle presentation on
You have 3 options in setting
their PCTV HD Stick at the
up the PCTV:
APCUG Convention in
1) Antenna (for digital/
2008, I have been itching
analog TV reception);
to get my hands on one. I
2)
Cable (analog TV
was imagining a new
reception);
widescreen computer
3) Capture from Cable/
monitor coupled with this
Satellite Set-top Box.
device as a means
of having a really cheap
For this review we will
HDTV. So I purchased
be using Option 1 –
a new widescreen
Antenna (digital/
monitor (22") and the
analog TV reception).
PCTV HD Stick. The
During setup, the
USB device comes in
PCTV will scan for SD
3 flavors, PCTV HD
and HD signals via the
($6999), PCTV HD Pro
included antenna. The
($99 99 ) and the top
antenna is designed for
of the line PCTV HD
digital and analog TV
Ultimate ($12999). There
reception in regions
is also an internal card
with fair to good signal
version ($7999). All these
coverage. When using
devices are designed for
the antenna, it should
Windows XP and are Vista Certified. There is a separate be fully extended in the upright position as high as
device with similar features for Mac users ($12999). I opted possible and near a window. The base of the antenna is
for the ‘Ultimate’ model because of its onboard memory magnetic so it should not be placed near a cathode ray
DVR and software. More on that later, but the Ultimate is a tube monitor, television or similar equipment as the
plug and play that allows you to start watching and record electromagnetic field of such devices might deteriorate
SD and HDTV almost immediately.
the signal quality. Also be careful with the magnetic base
around other objects that are sensitive to magnetic forces
Packaging
– i.e. PC hard drive. In my region I was able to download
The packaging contains a mini remote control including all the local SD and HD stations available within my
batteries, a portable telescoping high-gain antenna, A/V region via the antenna.
adapter cable, A/V adaptor cable, a USB extender cable
and the usual manuals and CDs. With the Ultimate model
you also get a neat soft leatherette carrying pouch.

Mark August 23rd
on your calendar

Setting Up
Setting up the PCTV Ultimate could not be easier. This
model has all the software preinstalled including the

It’s the Napa Valley Personal
Computer Users Group Picnic.
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Software

Windows Media Center

When you first install the PCTV HD Ultimate Stick, it
checks whether all the required drivers and the .NET 2.0
Framework are already on your computer and, if
necessary, installs them. After the initial startup, every
time you start the program, a TV screen appears
immediately on your desktop. The integrated memory on
the PCTV HD Ultimate Stick is divided into 2 different
areas or drives.
1) A re-writable memory area
(removable media area) with
the TVCenter Pro program
and available memory for
recorded shows or other user
data. The drive is labeled
PCTV flash.
2) A read-only memory area
(CD-ROM area) contains the
drivers. This drive is labeled
PCTV Start
Also included in the package is
Pinnacle Studio QuckStart that
allows you to edit your recordings or home movies and
transfer them to DVD, complete with custom menus and
soundtracks.

If you have a PC equipped with Microsoft Windows
Vista Home Premium or Ultimate or Windows XP Media
Center Edition 2005 and you want to watch and record
TV using the Windows Media Center application, then
you will have to run TV setup in that application. I’m
running Windows Vista Ultimate on my PC and using the
Windows Media Center software for my TV viewing and
recording, but you can use either
product. There is not a conflict
between the included software and
Windows Media Center. However,
the Windows Media Center
software overrides the included
TVCenter Pro software for TV
viewing and recording. The
included remote does not work with
Windows Media Center; however
you can select channels directly by
keyboard input and/or by mouse
when viewing TV via Windows
Media Center. You can also opt to
purchase a compatible Media
Center Remote control that is available from Pinnacle
for $2999. Again, to get the PCTV HD stick to work with
Windows Media Center is the matter of selecting the TV
setup in Windows Media Center and following the
onscreen instructions. Window Media Center will
recognize the device and do its own scan and download
a TV guide that is used to identify the channels and for
time shifting. The time shifting feature allows you to
record your favorite TV shows and play them back at a
later time. Windows Media Center does not support
some of the onboard memory features of the PCTV HD
Ultimate stick.

Controls
The package comes with a full-featured remote control.
Although small in size it does give complete control of
the PCTV. If you elect to use Windows Media Center, the
included remote will not work. You will have to purchase
a compatible Windows Media Center remote that is
available from Pinnacle.

Display
The first time Pinnacle TVCenter Pro is accessed, you
will see the Player. This screen can be full-screen or
resized to suit. There are navigation icons that select
settings, channels, TV or Radio and the program guide.

FM Radio
As sort of an added bonus, during setup PCTV stick also
scans for available internet radio signals for play back on
your PC. It categorizes them by genre rather than call
letters. Unfortunately, the software does not provide any
other information regarding the available stations or for
the music that is being played.

Picture Quality and Sound Quality
The quality of picture and sound is dependent on your
monitor and speakers. The PCTV HD stick is capable of
providing digital sound, SD and HD quality picture that
if is available within your region.

Conclusion
I now have my cheap HDTV and so far I have not been
disappointed. The PCTV HD is pulling free off the air HD
signals and displaying them on my monitor in full HD. The
PCTV HD Ultimate Stick is a slick ultra-portable USB
device that will allow you to watch and record SD and free
HD TV. The TV tuner and personal video recorder software
run directly from the Stick’s on-board flash memory, so you
can plug it into any PC and start watching and recording TV
in seconds – no installation required.
It supports both analog (NTSC) and digital (ATSC) TV
signals. The tuner hardware is also ready for ClearQAM
(unencrypted digital cable).
You can record up to 2 hours of TV directly to the stick for
playback on any PC and save recordings to your hard drive
in MPEG-1/2 or DivX formats or even direct-to-DVD.
This article has been provided to APCUG by the author solely
for publication by APCUG member groups. All other uses
require the permission of the author (see e-mail address above).
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E-Mailing Photographs
By Richard Kennon, Editor, Amador Computer Users Group, CA, www.acug.net,
Drtrdguy@volcano.net
Obtained from APCUG with the author’s permission for
publication by APCUG member groups.

First, we must understand that
photograph (image) size in the
camera and in the computer is
measured in pixels. These are the
basic dots of color that make the
picture. Do not pay any attention
to anything that says “inches” or
“pixels per inch.” These terms
are meaningless when we are
considering a picture either in the
camera or in the computer. They
may come into play later if we
want to print the photo on paper.
But, that is a subject for another
time. For now, we think only of
pixels. Most cameras record too
many pixels to e-mail. For
instance a 6 megapixel camera will make a picture about
3000 pixels wide by 2000 pixels tall and the file size may
be several megabytes. Our screens are usually only about
1000 pixels wide (some are larger and some smaller). So,
if we e-mail the native picture, it will be wider than the
screen for the recipient and the file will be so large, it may
take “forever” to download to the recipient’s computer. It
is possible the service provider will not even accept it.
There are two things we must
do to make a photo e-mailable.
The first is to resize or resample
the picture. We want to change
the picture width from 3000 pixels
to 800 pixels, for instance. This
process is called resizing or
resampling. We have to pick the
best 800 pixels out of the 3000 to
represent our photo. Well, no, that
is not exactly correct but it
simplifies things to think of it that
way. We don’t have to worry about
it because a lot of very smart
programmers have developed
ways (algorithms) to help us. Just
remember, you want to resize or
resample to get the photo down to
a size convenient for e-mailing. I
usually use 800 pixels or 900
pixels width for pictures I attach to e-mails.
The second thing to do to make a photo e-mailable is to
save it in JPEG format (.jpg). That is a format that
reduces file size a lot and picture quality a little so the

picture can be downloaded more quickly and still be nice
to look at. Some software programs give you choices
of compression amount with
numbers ranging from 1 to 10.
One will result in a very small
file but the picture quality will
not be good at all. A 10 will give
the very best quality but with a
very large file size. A reasonable
compromise is to use 5 or 6. I
usually use 6.
How do you do this? First, I
will describe how to do it with
a free Microsoft program.
Then I will try to look at some
other programs.
Microsoft Power Toys for XP
has a Resize Pictures toy that is
slick and easy but feedback says
it only works on XP. It can be
downloaded at h t t p : / / w w w . m i c r o s o f t .
com/windowsxp/downloads/powertoys/
xppowertoys.mspx. Right click on an image name
or thumbnail in Explorer or My Computer and choose
Resize Pictures. You are limited to four specific sizes but
they are good choices. They don’t tell us what compression
they are using but the results look OK. Unless you tell
them under Advanced to replace
the image in the file, it will make
a copy. That’s good. They
will add the word, “Large”,
“Medium” or “Small” to the end
of the name you have chosen.
If you are happy with this
solution, then read no further.
But, if you want to use a picture
editing program, maybe this will
help.
In Photoshop Elements 5, click
on Image>Resize>Image Size
and this window will pop up.
Note that there is some garbage
at the bottom about “inches” but
we will ignore that. First we will
click the Resample Image box.
That puts the Pixel Dimensions
in play and that is what we want.
I selected the Width box and changed the width to 800
pixels. Since the Constrain Proportions box is selected,
that is all I have to do.
Note, down at the bottom, that we have several choices
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dollars getting her computer back up. Oh, I digress. If
you want to send more than one picture (and, who
doesn’t?), you must select the picture and click on the
Hold button near the bottom of the screen. Do this for
each photo you want to send and they will all be
attached to the e-mail. The program automatically
chooses JPEG format and a compression ratio but does
not tell you. That is OK as the pictures I tried looked
good. Picasa2 has considerable capability for editing
photos in many respects. Try it!

of sampling algorithms. This is frosting on the cake. I read
somewhere that I should use Bicubic Sharper when
downsizing so that is what I do. Most programs don’t give
us all these choices. Then we should click on File>Save
As and give the photo a new name. I often just use the same
name and add “_800px” so the next time I will know it is
ready to e-mail. Here we can choose the JPEG format and
the compression amount. Photoshop Elements 6 is out
now and sells for about $100. If you are able to spend that
much and want one of the best editing programs, I highly
recommend it.
Let’s look at Picasa2. It is a free program from Google
and looks really good but I do not have much experience
with it. By all means, try it first because the price is right!
When it comes to e-mailing photographs, it is a little more
automated but not any easier to use than Elements. First,
click on Tools>Options>E-Mail. Then select the width
you want in pixels. There are six choices. Then click on
Apply and OK.
The next step is to click on File>E-Mail and you will get
three choices of how you want to e-mail your photos.
Fortunately, I use Outlook Express so my choice is listed.
When I clicked on Outlook Express, an e-mail page
popped up with the photo attached. At this point we can
write something else on the e-mail and send it. I
recommend this so the recipient will know it is really
from you and not something sent out by a virus. When
I receive e-mails that only say “Attached”, I Delete
them without looking at the attachment. This saved me
one time when I received a virus from my sister-in-law
that she did not know she sent. She spent weeks and

There are many other editing programs that I haven’t
mentioned and have no experience with. In all cases you
want to change the picture’s size in pixels by resizing or
resampling. Pay no attention to anything that says “inches”
as that will have no meaning for this process. Sometime
later we will talk about printing pictures and then we will
use inches.
This article has been provided to APCUG by the author solely
for publication by APCUG member groups. All other uses
require the permission of the author (see e-mail address above).
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Fr om Copies t o Full Co l or Printing

we ’re your
sou r ce for all your printed needs .
Also come see us for your Pr omo tional Items !

947 Lincoln Avenue
Napa, CA 94559-5066

3148 Jefferson Street • Napa, California 94558
707/257-6260 • fax 707/257-8741
napa@minutemanpress.com
http://napa.minutemanpress.com

(707) 299-1000
www.napanet.net • custserv@napanet.net

Napa Valley Personal Computer Users Group
Offering Financial Services
throughout the Napa Valley;
with offices in American
Canyon, Calistoga,
Napa, St. Helena
and Yountville
800-869-3557
www.wellsfargo.com

Thank
You !
The Napa Valley Personal
Computer Users Group is
grateful for the support
provided by the afore
mentioned companies

illegal character
A character, such as a period,
that isn't valid or can't be
used in certain commands
because the character is used
for some other reason within
the operating system.
This Daily Term is reprinted
with permission from Smart
Computing.
Visit
www.
SmartComputing.com/
Groups to learn what Smart
Computing can do for you and
your user group!

For more information about the
NVPCUG, visit our Web site:
http://www.nvpcug.org
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Firefox 3 – Hot New Browser
By Ira Wilsker, APCUG Director; Columnist, The Examiner, Beaumont, TX; Radio and TV
Show Host, Iwilsker@apcug.net
Obtained from APCUG with the author’s permission for and other information from IE, without making any changes
publication by APCUG member groups.

WEBSITES:
http://www.getfirefox.com – Free Download
http://www.mozilla.com/en-US/firefox/
features/ - Features
https://addons.mozilla.org/firefox/

- Add ons
After a lengthy wait, Mozilla has released the latest and
greatest release of the very popular web browser, Firefox 3.
This new release, available for free download from
www.getfirefox.com, has many new features, making it a
very strong competitor to Microsoft’s ubiquitous browser,
Internet Explorer.
Firefox evolved from an earlier browser, Mozilla, which in
turn grew out of the Netscape browser as AOL announced
the cessation of Netscape development. Since its first release
several years ago, Firefox in its current and previous versions
has developed a wide following, with hundreds of millions
of copies downloaded. The newly released version 3 has
tentatively set a Guinness world record with over 8 million
copies downloaded in its first 24 hours of public release,
despite overloaded servers that discouraged countless people
from downloading it the first day of issue. According to
published reports, the number of copies of Firefox 3
downloaded surpassed 14 million downloads in the first 72
hours. Obviously, many people are using it.
Rhetorically, so why are so many using Firefox 3 rather
than Internet Explorer (IE), which is installed by default on
all contemporary Windows computers? There are several
other fine browsers in circulation, such as the newly released
update to Opera, and Apple’s Safari
(for both Windows and Mac), but for
Windows computers, Firefox is firmly
in second place, right behind Internet
Explorer. If Internet Explorer was not
preinstalled on Windows computers
and integrated into the operating
system, there is a good chance that
Firefox 3 could surpass IE in a fair
competitive market. Firefox 3 is faster
rendering web pages than IE, has
superior tabbed browsing, is written
in tighter code taking fewer system
resources, and has many advantages over IE. There is no
reason why PC users should not download Firefox 3 for
Windows (7.8mb download), and install it, as it runs happily
on computers that already have IE installed. On a fresh
installation of Firefox on a Windows computer, Firefox will
nondestructively import the favorites (bookmarks), cookies,

or impeding IE in any way. If Firefox 3 is installed on a
computer that has an older version of Firefox installed, it will
automatically install it as an upgrade, including all bookmarks,
passwords, cookies, and other information. Once installed,
many users, such as me, prefer to use Firefox instead of IE.
In my case I would say that I use Firefox for 98% of my
browsing tasks; it would be 100%, but I have IE setup to
access another internet account that I have, but rarely use.
According to the Firefox 3 website at
www.mozilla.com/en-US/firefox, over 15,000
improvements were made to version 3 over version 2. The
newly released version 3 is claimed to be faster, safer, and
smarter than the previous version, and also IE! One of the
new features, which I have personally verified, is the fact that
web pages do indeed load faster than on IE and previous
versions of Firefox. Firefox 3 also consumes less system
memory and system resources, leading to improved computer
performance when Firefox is loaded
and running, compared to the previous
version, or even IE. Firefox 3 is also
more secure than previous browsers,
and incorporates the latest technologies
to help prevent phishing (identity theft),
and other website forgeries. A neat new
feature in Firefox 3 is “Instant Website
ID”, where clicking on the tiny website
icon (“site favicon”) at the left of the
URL in the menu bar will display site
information and identification, which
will likely indicate if the site is as
intended, or a web forgery. Firefox 3 has also been engineered
to work smoothly and compliment Vista’s parental controls,
as well as most antivirus and other security programs.
Another interesting feature unique to Firefox 3 is the “Smart
Location Bar” that shows detailed information on websites
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Foxfire cont. on page 16

Foxfire cont. on page 15

recently visited, and is accessed by
clicking on the right side of the
menu bar. This Smart Location Bar
is intelligent, in that it adapts to
persona preferences to locate better
website matches. Typing a “tag” or
keyword in the menu bar opens a
detailed list of previously visited
websites containing that keyword,
making it very fast and easy to
locate websites that have previously
been visited. Another very useful
feature is the integrated spell checker, which underlines any
misspelled words typed in a browser window; right clicking on
the word opens a list of suggested spellings, which a mouse
click will instantly replace the incorrect word with the correctly
spelled word.
Malware of various types, including worms, Trojans, viruses,
and spyware is a growing menace to internet users. Firefox 3
integrates a sophisticated anti-malware feature that provides
some protection if the user either intentionally or erroneously
accesses a website that contains attack code. If such a dangerous
website is accessed, a full screen (browser window) display
will appear as a warning. Firefox, working with other
organizations (including Google) maintains a continuously
updated list of so called “attack sites”, so there is nothing for
the user to update or maintain. In the event the user does
happen to fall into a suspect
site, such as a very freshly
created phishing (identity
theft) website, the forgery can
be quickly reported by simply
clicking on HELP – REPORT
WEB FORGERY; this will
connect to a Google service
that collects such information
on a real-time basis, verifies
the forgery, and automatically
adds it to the malware list, as
well as forwards the information to groups like Phish Tank
(www.phishtank.com) for further action.
Many of us use multiple passwords and user names on
countless websites. Firefox 3 has an excellent integrated and
Napa Valley Personal Computer Users Group
P.O. Box 2866
Napa, California 94558-0286
Address Services Requested

secure password manager. When a
password is first entered, Firefox 3
asks if you want it to remember that
password and logon information,
without any annoying pop-ups.
Speaking of pop-ups, Firefox 3
incorporates a sophisticated and easily
configurable pop-up blocker which can
stop pop-ups and pop-unders, speeding
and making more enjoyable the surfing
experience. In some cases, pop-ups
are not irritating advertisements, but
instead contain important information;
these can be easily allowed when desired.
Many of us choose to tweak the appearance and features
of our browsers, and Firefox 3 happily obliges. Firefox has
many themes and “personas” that can be selectively
implemented to change the appearance of the browser to
meet our individual tastes. For those of us who want
additional features, Firefox offers over 5,000 free “addons” (addons.mozilla.org/firefox), which are
easy to install devices to customize the browser to work as
desired. I have installed about a dozen add-ons, including
some security add-ons (PhishTank, McAfee SiteAdvisor,
and others), as well as an enhanced download manager (the
one integrated in Firefox 3 is very adequate for most users).
I also have selected to use differently colored tabs on the
top of the browser window, an add-on that can make a tab
an IE window (for the rare
cases when a website is
intended for IE only), a
PDF manager, and several
other add-ons.
Firefox 3 is an outstanding
and free product. It is a very
worthwhile competitor to
Internet Explorer, and users
should try it to see if they
like it. I like it, and use it
almost exclusively on my
desktop and notebook computers. That is the best
recommendation I can give it.
This article has been provided to APCUG by the author solely
for publication by APCUG member groups. All other uses
require the permission of the author (see e-mail address above).

